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Video Support
This Introduction Workbook has supplemental video support available. Each 
chapter uses step by step instructions supported by on line videos to view and 
review the material as needed. Scan the code below or use this link to access the 
videos (https://aglt.co/ChemVistaIntro).
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Agilent Community

Agilent Community

To get answers to your questions, join over 10,000 users in the Agilent 
Community. Review curated support materials organized by platform technology. 
Ask questions to industry colleagues and collaborators. Get notifications on new 
videos, documents, tools, and webinars relevant to your work.

https://community.agilent.com/
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1 Introduction 
About this Training Workbook
About this Training Workbook

This Training Workbook provides instructions on the features of ChemVista 
Library Manager 1.0.

For additional information on the software and detailed instructions on the 
features not covered in this workbook, refer to the Online Help.

Use the following exercises to experience how to utilize ChemVista Library 
Manager to import library data, organize via search and list creation, edit 
structural and compound metadata, and export to desired formats. Example data 
is provided with the installation of the software to introduce these steps.

How This Training Workbook Works

This training workbook is your introductory guide for the set-up and execution of 
ChemVista Library Manager 1.0. This workbook is divided into several chapters, 
each building upon the last, so we recommend that each chapter is completed in 
succession. During each chapter, lessons are guided step by step.

Instructions look like this:

Tasks or items needed to complete tasks look like this.

If you are expected to enter any information or if something is important, it is 
set in italicized type like this:

Type Blank One in the field.

If you are expected to press a key on the keyboard or button on the software 
screen, the key is displayed in bold like this:

press Enter.

Cross references appear in blue:

(For example, Link)
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1 Introduction 
Notes and Alerts
Instructions for procedures are presented in a numbered step format:

1 Start the software by clicking the icon on the desktop. The main software 
window appears.

Notes and Alerts

NOTE
The Note text appears here.

CAUTION
The Caution text appears here.

WARNING
The Warning text appears here.

What This Training Workbook Covers

In this learning experience, the goal is to get up and running using the software 
as quickly as possible. After completing this learning ChemVista Library 
Manager event, you will have an introductory level of experience in the use of 
ChemVista Library Manager 1.0.

This learning experience introduces basic concepts in a learning-by-doing, 
guided manner. Each chapter uses step by step instructions and is supported by 
on line videos to view and review the material as needed. Scan the code to the 
right or use this link to access the videos (https://aglt.co/ChemVistaIntro). At 
any time if you have a question or get stuck, to find your local sales and support 
contact, visit the following page using the link below.

• https://www.agilent.com/en/contact-us/page

For technical support, visit the following page:
• https://www.agilent.com/en/support
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1 Introduction 
Requirements
Requirements

To complete the chapters in this training workbook, you need to have installed 
the software to the most recent release recommended. The software is found on 
the install media provided in the install kit, along with specially prepared data 
sets to load onto the software system before the start of this learning exercise.

Please refer to the Online Help or Installation Guide for further information. As 
always, feel free to contact Agilent Support for additional assistance.
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2 User Interface and General Navigation

Launching ChemVista Library Manager 12

User Interface 13

Pages 15
Home Page 15
Search Page 17
Import Page 18
Jobs Page 20
Lists Page 21
System Page 22
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2 User Interface and General Navigation 
Launching ChemVista Library Manager
Launching ChemVista Library Manager

1 After software installation, double-click the ChemVista Library Manager icon 
or Click Start > All Programs > Agilent Technologies > ChemVista Library 
Manager.

2 The software splash screen shows the software initialization.

NOTE
The splash screen displays the build number of the software, which is needed 
when contacting support. This information is also available in the File>About 
section of the software.
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2 User Interface and General Navigation 
User Interface
User Interface

Navigation Ribbon

Ribbon Definitions

File Tab - The following commands are available on the File menu.

• Help opens the Online Help file.
• About opens the About Dialog Box
• Exit closes the program.
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2 User Interface and General Navigation 
User Interface
Home tab - The ribbon has two groups with the following commands and pages:

The Home tab has two groups with the following commands and pages.
• History

• Back returns to the previous page.
• Reload reloads the current page, updates values, and resets entered text.
• Forward goes to the following page.

• Pages:
• Home
• Search
• Import
• Jobs
• Lists
• System
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2 User Interface and General Navigation 
Pages
Pages

The pages and their basic functionality used for these exercises is reviewed in 
this section. For further definitions or advanced functionality, refer to the Online 
Help. 

Home Page

Home Page Definitions

The Home page is shown when  is clicked on the Ribbon.
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2 User Interface and General Navigation 
Home Page
Functionality

The Home page shows overall substance and spectral counts and features the 
ability to search by name, synonym, CAS, or formula. Enter part or all of the name, 
synonym, CAS, or formula to search for in the field and press Enter on the 
keyboard to return results. 

Recent lists

Each box represents a different list, up to 12 recently edited lists are displayed. 
The box displays the name of the list and how many substances are in the list.

Recent jobs

Each box shows jobs that have been started in the last 24 hours.
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2 User Interface and General Navigation 
Search Page
Search Page

Search Page Definition

Click  on the Ribbon to show the Search page.

Functionality

This page is used to search within ChemVista by Identifiers, Formulas, Mass, 
Tags, or Lists and to view the results of a search.
ChemVista Library Manager 1.0 Introduction Workbook 17



2 User Interface and General Navigation 
Import Page
Import Page

Import Page Definition

Click  on the Ribbon to show the Import page.

Functionality

This page is used to import data into ChemVista from multiple formats.

Source Types

The type of file to be imported. The options include:
• PCDL (*.cdb)
• PCDL CSV (*.csv)
• MassBank (*.txt)
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2 User Interface and General Navigation 
Import Page
• SDF (*.sdf)

NOTE
Refer to the Appendix for more information on file types, sources, and examples.
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2 User Interface and General Navigation 
Jobs Page
Jobs Page

Jobs Page Definition

Click  on the Ribbon to show the Jobs page.

Functionality

This page is used to display information on any data operation (for example, 
import, add, edit, restore) when created as a job.

NOTE
Any operation that only affects lists (for example creation or editing) does not 
create a job.
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2 User Interface and General Navigation 
Lists Page
Lists Page

Lists Page Definition

Click  on the Ribbon to show the Lists page.

Functionality

From this page, create, remove, or merge lists, which then display in a table. List 
names are active links that display the substances in each list when clicked. 
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2 User Interface and General Navigation 
System Page
System Page

System Page Definition

Click  on the Ribbon to show the System page.

Functionality

From this page clear system data, review registered Data Field definitions, 
changes, installed source types or review applications settings.

NOTE
These actions should only be done if you understand the effects. Please consult 
the Online Help for further information.
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3 Importing Data 
3 Importing Data

Import Files 24
Introduction 24
Import data from PCDL 24
Import data from Mass Bank 26
Import data from PCDL.CSV 27
ChemVista Library Manager 1.0 Introduction Workbook 23



3 Importing Data 
Import Files
Import Files

Introduction

The following exercises are designed to support the execution of the ChemVista 
Library Manager features along with video support. The videos are intended to 
provide visual support for working with the software. We recommend reviewing 
the video demonstration first, then attempting the processes, using each 
exercise as a guide. If at any time you have questions or run into an event that is 
not in alignment with this workbook, please reach out to Agilent Support or your 
Agilent Consultant.

Import data from PCDL

1 Click Import on the Ribbon to navigate to the Import Page.

2 Select PCDL(*.cdb) from the Source type drop-down.
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3 Importing Data 
Import data from PCDL
3 Click Open file(s).

4 Navigate to the folder “\Resources\Example Data\PCDL” and select 
Checkout_TestMix_Std.cdb and Pesticides_Submix1.cbd.

5 Click Open.
6 Select Create List Upon Import. 
7 Enter the name Pesticide List into the List Name field.
8 Enter Checkout Test Mix and Pesticides Submix PCDLs into Description.
9 Select Import selected files to launch the import.

10 Click OK.

NOTE
The PCDL is not saved within the software, the data is imported from the PCDL 
and stored in the software’s internal format.
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3 Importing Data 
Import data from Mass Bank
11 Review the Status of the import from the System Jobs page to confirm it 
reads Import complete.

12 Expand the Summary to review the number of substances created and 
spectra imported. 

Import data from Mass Bank

1 Click Import on the ribbon to navigate to the Import Page.

NOTE
The MassBank files provided with the installation software are only for 
instruction purposes. It is advised to obtain updated files from MassBank before 
performing analysis beyond performing these exercises.

2 Select MassBank (*.txt) from the Source type drop-down.
3 Click Open file(s).
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3 Importing Data 
Import data from PCDL.CSV
4 Navigate to the folder "\Your Directory\Example Data\" and select the 
MassBank files folder.

5 Click Open.
6 Clear the Create List Upon Import check box.

7 Click Import Select Files to launch the import.
8 Click OK.
9 Expand the Summary to review the number of substances created and 

spectra imported. 

NOTE
The MassBank files are not saved within the software, the data is imported from 
the files and stored in the software’s internal format.

Import data from PCDL.CSV

1 Click Import in the Ribbon to navigate to the Import Page.
2 Select PCDL CSV (*.csv) from the Source type drop-down
3 Click Open file(s).
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3 Importing Data 
Import data from PCDL.CSV
4 Navigate to the folder "\Your Directory\Example Data\" and select 
Pesticides_submix1_RT.csv.

5 Click Open.
6 Select the Create List Upon Import check box.
7 Enter the name Pesticide Submix Subset into the List Name field.
 

8 Select the Apply method label to imported data check box.
 

9 Enter Agilent Eclipse Plus C18, 2.1 mmx150 mm, 01/2021 into the label field.
10  Click Import selected files to launch the import.

NOTE
Creating a method label is strongly recommended for optimal RT/RI data 
organization, especially from PCDL and CSV imports. The method label is stored 
alongside RT/RI data and enhances viewing and downstream use.

11 Click OK.
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3 Importing Data 
Import data from PCDL.CSV
12 Expand the Summary to review the number of substances created and 
spectra imported. 

13 Click Lists on the Ribbon to view the Substance List pane.
14 View the Substances Lists, noting the two lists created via import display. 
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4 Lists 
Working with Lists
Working with Lists

Tag Search

1 Click Search on the Ribbon to navigate to the Search Page.
2 Click the Tags tab.

NOTE
Tags come from rich data that's included as part of the Agilent PCDL files. 
They're parsed from the compound Description and Notes fields and presented 
as a separate, searchable tag that travels along with the compound information.

3 Enter pesticide into the search field, then select it from the auto-generated list.

4 Click Search to load the subset in the Search Results window.
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4 Lists 
Create a Targeting List from Search Results
NOTE
Tags are removed by clicking on the text to clear from the search list.

Create a Targeting List from Search Results

1 Use the Select All check box to select all compounds in the Search results.

2 Click Add to list.
 

3 In the Add to new list section of the dialog box, enter the List name 
Comprehensive Pesticide List.
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4 Lists 
Create a Targeting List from Search Results
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4 Lists 
Manage Lists from Lists page
4 Click Create list.

5 Click OK.

Manage Lists from Lists page

1 Click Lists on the Ribbon to navigate to the Lists page.
2 Select the Pesticides Submix Subset and the Comprehensive Pesticide List's 

check box. 

3 Click Merge.
 

4 In the Add to List dialog box, select the List drop down and choose 
Comprehensive Pesticide List.

5 Click Append.
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4 Lists 
Manage Lists from Lists page
6 Click OK. 
7 The Substance Lists page refreshes and the Comprehensive Pesticidelist 

displays 47 in Substance count.
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5 Working with Data 
Editing Compounds
Editing Compounds

Adding Compounds to List

1 Click Search on the Ribbon to navigate to the Search page.
2 Select the Identifiers tab.
 

3 On the Identifiers tab, select the identifier field CAS. 
 

4 Enter 2886-65-9 in the search field.
 

5 Click Search.
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5 Working with Data 
Create a New Substance
6 Select Norfluradiazepam.
 

7 Click Add to list.
8 Select Comprehensive Pesticide List.
9 Click Append.
10 Click OK.

Create a New Substance

1 Click Lists in the Ribbon to navigate.
2 Click Comprehensive Pesticide Screening list name to view.
 

3 Click Create substance.

 

4 Enter the following information:
•  Name: Difenoxuron
•  CAS: 14214-32-5
•  Formula: C16H18N2O3
•  SMILES: COC1C=CC(=CC=1)OC1C=CC(=CC=1)NC(=O)N(C)C
•  Mass: 286.13174
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5 Working with Data 
Create a New Substance
NOTE
Adding any single structural identifier results in the creation of any missing 
identifiers, including InChI String, InChIKey, MOL text, and a structural image.

5 Click Commit. The Systems Jobs pane displays.
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5 Working with Data 
Editing Spectra
Editing Spectra

Add New Spectrum

1 From Systems Jobs page, click View Affected Substances.
 

2 Click View spectra. 
 

3 Click Create.
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5 Working with Data 
Add New Spectrum
4 Add the following information into m/z and Intensity:

5 Edit the Spectral Details with the following information:
• Separation technique: LC
•  Mass Analyzer: QTOF
•  Ionization Technique: ESI
•  Polarity: POSITIVE
•  Precursor Type: [M+H]+
•  CE: 10
•  Precursor ion: 287.1390189076
•  MS Level: 2

m/z Intensity

46.065126 19.316

72.04439 32.018

123.044056 18.668

124.051881 1.139

287.139019 100
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5 Working with Data 
Add New Spectrum
6 Click Commit.
7 From Systems Jobs, click View Affected Substances.
8 Click View Spectra to verify that the data was added.
9 Review the data as needed.
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5 Working with Data 
Verifying Spectra
Verifying Spectra

1 Click Lists on the Ribbon to navigate to the Lists page.
2 Click Comprehensive Pesticide List to view the list of compounds.
3 Sort the list alphabetically by clicking the Substance Name column header.

4 Highlight Bentazone.

5 Click View Spectra.
6 Click Polarity.

7 Select Negative.

8 View Negative mode spectra and confirm 3 spectra are present.
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5 Working with Data 
Update RT
Update RT

1 From the ribbon, click Back to return to the prior page.
2 Click Browse Methods.
 

3 Click Select method label or parameters to view the methods available. Click 
anywhere to close.

4 Click Edit RT /RIs.
 

5 Type in Agilent Eclipse Plus C18, 2.1 mmx150 mm, 02/2023 in the Method 
Label field.

 

6 Click the RT column header to sort the list.
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5 Working with Data 
Update RT
7 Add additional Retention times in the RT column as needed.
 

8 Click Commit.
9 To confirm the data is loaded in the software, click Back on the Ribbon. 

10 Click Reload on the Ribbon of the Methods page.
 

11 Select method label or parameters to confirm the method was applied to the 
list.
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6 Exporting Data

Exporting a List 48
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6 Exporting Data 
Exporting a List
Exporting a List

1 Select the Select All check box.
 

2 Click Export to navigate to the Export Page and display options.
 

3 Confirm that PCDL (*.cbd) is selected for Export As. 

4 Click Ionization technique and select ESI.
5 Click Polarity and select Positive.
 

6 Click Method label and select Agilent Eclipse Plus, C18, 2.1 mmx150 mm, 
02/2023.
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6 Exporting Data 
Exporting a List
7 Click Summary Load Statistics to review summary statistics of the data 
included in the export.

CAUTION
Loading of Summary Statistics may take several minutes if the exported data 
set is large. 

8 Click Start Export.
 

9 Click OK.
10 Click Download output.

 

11 In the Save file dialog box, browse to the desired location to save the file.
12 Enter a name for the output and click Save.
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7 Appendix 
Tips
Tips

Using exported PCDLs in MassHunter data analysis

Exporting PCDLs from Agilent ChemVista enables screening and identification 
workflows in downstream MassHunter data analysis software. For guidance on 
using PCDLs in MassHunter Quantitative Analysis, refer to the MassHunter 
Quant LC/Q-TOF Screener (M6005-10006).
Spectra and RTs can be extracted in MH Qual and sent to a desired PCDL. Once 
the desired spectra and RTs are in the PCDL, import the PCDL into ChemVista. 
The import process will use the structural identifiers and meta data to merge 
data together and eliminate duplicate compounds and will store the new spectra 
and RTs accordingly. On import, create a method label to keep RTs organized.

Data Format 

Format Support File 
Type

Example Data/Access

Agilent PCDL .cdb E:\Resources\Example Data 

CSV .csv E:\Resources\Example Data
E:\Resources\Templates
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7 Appendix 
3rd Party Resources
3rd Party Resources

MassBank (EU)

Spectra from MassBank is viewed on the MassBank web application 
(https://massbank.eu/MassBank/) and downloaded via the MassBank data 
repository hosted on GitHub (https://github.com/MassBank/MassBank-data) 
as .txt files. The data repository is organized in sub-folders according to the 
contributor or contributing group. Each .txt file contains a single spectral record 
and there may be many .txt files mapping to the same chemical substance or 
compound. Downloaded .txt files are imported directly into ChemVista.

MassBank of North America (MoNA)

Spectra from MoNA is viewed and downloaded from the MoNA web application. 
Spectra are downloaded from MoNA 
(https://mona.fiehnlab.ucdavis.edu/downloads) in three different formats, but 

Format Support File 
Type

Example Data/Access

MassBank EU .txt E:\Resources\Example Data
https://massbank.eu/MassBank/ 
https://github.com/MassBank/MassBa
nk-data 

MassBank of North 
America (MoNA)

.sdf https://massbank.us/ 
https://mona.fiehnlab.ucdavis.edu/do
wnloads 

EPA CompTox 
Chemicals Dashboard

.sdf https://comptox.epa.gov/dashboard/ 
https://comptox.epa.gov/dashboard/c
hemical-lists 
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7 Appendix 
EPA CompTox Chemicals Dashboard
the format supported by ChemVista is the SDF. The SDF download is organized 
by spectral record, but all entries in the download are contained in a single 
downloaded file. Downloaded SDFs are imported directly into ChemVista.

Many subset downloads are available from the MoNA downloads page, the 
following are recommended downloads to supplement Agilent MassHunter data 
analysis applications:

• All LC-MS/MS QTOF download
• All LC-MS/MS Agilent QTOF download
• All LC-MS/MS Orbitrap download

EPA CompTox Chemicals Dashboard

The EPA CompTox Chemicals Dashboard is a chemical data resource. Data is 
downloaded from multiple places in four different formats, but the format 
supported by ChemVista is the SDF (in either v2000 or v3000 MOL format). Data 
can be downloaded from pre-curated lists of interest 
(https://comptox.epa.gov/dashboard/chemical-lists) as well as from batch 
searches (https://comptox.epa.gov/dashboard/batch-search) conducted in the 
Dashboard web application. No spectra are available for download from the 
Dashboard. 

Suggested export filters for MassHunter data analysis

When using third party data in MassHunter workflows, the possibility exists that 
certain spectra are not compatible with MassHunter data analysis algorithms. 
For maximum compatibility, the following export filters are recommended:

• MS level = 1 or 2
• Polarity = NEGATIVE and/or POSITIVE
• For optimal library matching, restricting the instrument type to 'QTOF' is 

recommended.

NOTE
MS Level 2 is for LC-MS/MS and GC-MS/MS; MS Level 1 is for GC-MS.
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7 Appendix 
Common regex searches for Pattern Search
NOTE
Forcing a polarity to be selected removes spectra that have errant polarity values 
from third party sources that would cause issues in data analysis.

NOTE
Collision Energy (CE) values that are not supported in the PCDL format (e.g., 
'Ramp 21.1-31.6 eV') are written out by ChemVista with the value '9999' in the CE 
field in the exported PCDL.

NOTE
For maximum compatibility with the PCDL format, the presence of a formula and 
mass are required for chemical substances to be included in the export. This 
export option is automatically enforced for PCDL exports. For consistency and 
compatibility outside of MassHunter workflows, it is recommended to select the 
same filter when exporting to SDF or MassBank.

Common regex searches for Pattern Search

The Pattern Search option on the Search page in ChemVista supports regular 
expression (regex) inputs for the selected data field. Some common regex 
queries that might be helpful are provided below:

Regular Expression Search Conducted

(?i) When used prior to a search string, makes 
the search case insensitive (“(?i)pesticide”)

. Matches anything

\d Matches any digit 0-9

[a-d] Matches anything containing any of the 
letters a, b, c, or d

[0-9] Matches anything containing any of the 
values 0, 1, 2, 3, 4, 5, 6, 7, 8, or 9

^([0-9]|[1-9][0-9]|[1-9][0-9][0-9])
$

Matches any value between 0 and 999
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